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Section 1: Safety Intelligence Home Page 
 
What’s new? 
Reporting has been made effortless with our new dashboards. These dashboards have a 
modern look and feel, they are completely customizable, have user-friendly filters and provides 
easy workflows of creating and editing.  
 
The Home Page consists of various tabs 
 
Reports Home  
Contains a list of all the Dashboards and Looks including standard out of the box dashboards. 
The standard dashboards are present the Library folder. 
 

  
 
Folders 
 
Folders are containers that hold Dashboards and Looks. It helps to keep your data organised. All 
the dashboards can be accessed from the folders they are saved in. 
 

• Library folder – Consists of Overviews and Supplementary folders in which the standard 
dashboards are present.  

• Your Organisation folder – Any Dashboard and Looks saved in this folder would be 
accessible to all the authorized users across your organisation.  

• Personal Folder – contains user-created dashboards and Looks, typically ones that you 
are developing or that are mainly of interest to you. 
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Favorites 
 
Favorites shows a list of Looks or dashboards that you’ve marked as favorites by clicking the 
heart icon on the right side of the content’s listing in a folder. 
 

 
 
Recent 
 
Recently Viewed shows a list of your most recently viewed content, which can help you quickly 
revisit items of interest. The list is by default sorted by Last Viewed in ascending order. 
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Popular 
 
Popular shows a list of the most visited content, which can help you get acquainted with the 
most useful items. 
Click on More in the toolbar to see list of popular items. Popularity score is calculated based on 
the number of times the Dashboards and Looks are viewed.  
 

 
 

Section 2: Creating new folders 
To keep your data organised, you can create new sub folders under Your Organisation’s Folder 
and Personal Folder.  
 
Steps: 

1. Navigate Folders tab 
2. Select Your Organisation Folder or Personal Folder 
3. Click on Create on right side of the page 
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4. Give a Title and select the folder under which you wish to create the sub-folder  
 

 
 
The new sub-folder will now appear under Your Organisation’s Folder. You would be able to 
save dashboards in these newly created folders. 
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Section 3: Editing a dashboard 
 
Saving a new copy of the dashboard 
 
The standard dashboards (in Overviews and Supplementary folders) cannot be edited. 
However, changes to the filter can be made and the dashboard can be saved as a separate copy 
under any of the other folders or sub-folders. 
 
Steps: 

1. Change the values in any of the filter(s) and click on icon on right side of page to Save 
new copy of the dashboard 

 
 

2. Give a Title and Save in the desired folder. 
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Adding dashboard filters 
 
Steps: 

1. Navigate to any of the dashboard in Your Organisation’s Folder or Personal Folder. 
2. Click on three dots on right side of the pageàEdit Dashboard 

 

 
 

3. A Blue toolbar with would appear. Click on Add Filter 
 

 
 

4. Add Filter window appears pre-populated with fields from any Explores that are used in 
the dashboard 

5. You can use the search bar to find the field you want to filter by, or you can select it 
from the drop-down menu 
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Dashboard filters use fields only from Explores that are used in that dashboard’s tiles. 
You cannot select a field that is already being used by another filter.  
 

6. After you select the field you want to filter by, a filter configuration window appears 
that allows you to customize your filter settings 
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a) Title: Enter the title of the filter as you want it to appear on the dashboard. The title 

option pre-populates with the name of the filter-by field. 
b) Control: Select from a list of control types, which vary depending on the type of data 

you are filtering.  
c) Display: For controls that can be displayed as either inline or popover, select how the 

filter will be displayed.  
d) Values: To set specific value options for the filter, choose from the drop-down or enter 

the value options in this field. Leave blank to allow value options from the database to 
be surfaced, up to the maximum number of values available for that control. For 
numeric data, this field is replaced by Min and Max fields. 

e) Configure Default Value: Optionally, set the default value for the filter. 
f) Require a filter value: Select the checkbox to require a value for the filter.  
g) Select filters to update when this filter changes: Select the checkbox to link other filters 

to this filter. If there are no other filters on the dashboard, this option will be disabled. 
h) Add and Cancel: Click one of these buttons to save or cancel the new filter. 

 
7. Tiles to Update tab: User can then select either all or few of the tiles to update with the 

new filter and then click Add to add the new filter. The new filter would then appear 
with all the other filters on the dashboard and the selected tiles will be updated with the 
new filter. 
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Adding Tiles 
 
To be added 
 
Rearranging and resizing dashboards 
 
When in edit mode, you can move and resize tiles on a dashboard by clicking and dragging.  
 
Click and drag on the six-dot icon in the upper left of a tile to move it. Click and drag on the 
bottom right corner of the tile to resize it. 
 

 

Section 4: Scheduling and sending Dashboards 
 
Users can schedule immediate or recurring delivery of dashboards to anyone in your 
organization.   
Steps: 

1. Make sure the dashboard is not in edit mode. Click on three-dot menu in the upper right 
of the dashboard and choose Schedule delivery. 
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2. Once you click Schedule delivery, either an existing schedules window appears or 
a schedule and send window appears, depending on whether or not you have already 
created existing schedules on the dashboard 

3. Existing schedules window: If you have already created schedules for this dashboard, an 
existing schedules window appears that shows the schedules you have set along with 
some information about each one, such as destination and format. Deliveries using 
the Send now recurrence and schedules made by other people do not appear in this 
window. 
 

 
 

a. Click Send now to send an immediate delivery of existing scheduled content 
without disrupting the scheduled cadence. 

b. Click the three-dot menu to edit, duplicate, or delete a schedule. 
c. Click Done to exit the window. 
d. Click New to open the schedule and send window and create a new schedule or 

immediately send a new delivery. 
 

4. Schedule and send window: If you click New from the existing schedules window, or, if 
you do not have any pre-existing schedules for the dashboard, a schedule and send 
window opens. This window allows you to customize recurrence, destination, format, 
filters, and more: 
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a. The Settings tab this in window allows you to customize your delivery’s 
recurrence, destination, format, and more. 

b. The top of this window shows the name automatically given to the delivery. The 
name defaults to the dashboard’s name. To edit the delivery’s name, click the 
name (indicated by the dotted underscore), and make your edits 

c. The Filters tab in this window shows any filters applied to the dashboard as well 
as their values. In this tab, you can edit the values for any existing filters applied 
to the dashboard and the new values will be applied to the delivery. The 
dashboard itself will not be affected. 

d. You cannot add filters to your schedule in the Filters tab, only view and edit the 
values for existing dashboard filters. 
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When dashboard filters change: Sometimes dashboard filters change after a schedule is 
created. The table below explains how that affects filters applied to the scheduled deliveries. 
 

Action Effect on Schedule Filter 
A schedule is created with a filter. Later, 
the filter value is changed on the 
dashboard. 
 

No effect on the schedule filter value. It 
remains the value set in the Filters tab, 
even if that value is is any value 

A schedule is created with a filter. Later, 
the filter is renamed in the dashboard 

The filter is removed from the delivered 
data 

A schedule is created with a filter. Later, 
the filter is deleted in the dashboard 

The filter is removed from the delivered 
data 

A schedule is created. Later, a new filter is 
added to the dashboard 

The filter is applied to the delivered data, 
using the filter value set in the Filters tab. If 
no value is set in the Filters tab, the value is 
interpreted as is any value, essentially 
removing the filter 
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e. In Advanced Options tab you can include a custom message for your email 

delivery 
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Section 5: Downloading Content 
 
Downloading data from a dashboard 
 
To download the entire dashboard, select Download from the dashboard’s three-dot menu. 
 

 
 
This opens a dialog box that allows you to select PDF or CSV as your download format. 
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a) Select PDF from the Format drop-down menu. 
b) Select an option from the Paper Size drop-down menu. The Fit Page to 

Dashboard option is the default; it sizes the PDF to match the layout of the dashboard 
on the screen. 
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c) If you select something other than Fit Page to Dashboard in the Paper Size drop-down, 
an Orientation option appears. You can choose to orient the dashboard in portrait or 
landscape position. 

d) Select or leave unselected Expand tables to show all rows. If you select this option, for 
dashboard tiles that use table visualizations, the PDF will show all the rows available in 
the table visualization, not just the rows displayed in the dashboard tile thumbnail. If 
you do not select this option, only the rows that are seen in the thumbnail without 
scrolling will appear on the PDF.  

e) Select or leave unselected Arrange dashboard tiles in a single column. If you select this 
option, the PDF displays dashboard tiles in a single vertical column. If you do not select 
this option, the dashboard tiles appear as they are arranged in the dashboard. 

f) Click Open in Browser to see an image of the PDF in a new tab of your browser. From 
there, you can opt to download the PDF using your browser’s controls. 

g) Click Cancel if you no longer want to download the dashboard. 
h) Click Download to initiate the download. A new tab in your browser will open, showing 

the status of your download. 
 
Downloading a dashboard as CSVs 
 
You can download all the query tiles from your dashboard as a zipped collection of CSV files. 
Text tiles are not included in the ZIP file. To download your dashboard as a collection of CSV 
files, follow these steps: 

 
 

 

a) Select CSV from the Format drop-down menu. 

b) Click Cancel if you no longer want to download the dashboard. 

c) Click Download to initiate the download your zipped CSV collection. 

Downloading data from dashboard tiles 
 
To download the data from a dashboard tile, click the three-dot icon on the tile and 
select Download: 
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This opens a dialog box with several options. Expand the Advanced data options menu to see 
all available options for your download: 

 



 19 

a) Data can be downloaded from dashboard tiles in the following formats: 

• TXT (tab-separated values) 

• Excel spreadsheet (Excel 2007 or later) 

• CSV 

• JSON 

• HTML 

• Markdown 

• PNG (image of visualization) 

 
Depending on the format you select, some options in the Advanced data options menu may 
not be available. 

 
b) In the Results section, choose whether you want visualization settings applied to your 

data download. If you choose As displayed in the data table, visualization options will 
not be applied, and the download will appear like the data table in the Data section of 
the tile’s underlying data table. 
 

c) In the Data values section, choose how you want the downloaded results to appear: 

• If you choose Formatted, the data will appear more similar to 
the Explore experience in Looker. 

• If you choose Unformatted, Looker does not apply any special formatting of your 
results, such as rounding long numbers or adding special characters may have been 
put in place. This is often preferred when data is being fed into another tool for 
processing. 

d) You can specify how much data is included in your download in this section. In most 
tiles, this section of the download pop-up is named Number of rows to include; if the 
tile query contains any pivoted dimensions, this section is named Number of rows and 
columns to include. Your options include: 

• Current result table: Number of rows specified by the row limit — and column limit, 
if the tile query contains at least one pivoted dimension — of your tile’s underlying 
data table. 

• All results: The maximum Looker can display is 5000 rows. Check this option when you 
need to when you need to download complete data. 

• Custom: A custom number of rows to download. The maximum Looker can display is 
5000 rows.  
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Section 6: Sending conditional alert notifications 
 
With conditional alerts, you can specify conditions in your data that, when met or exceeded, 
trigger a notification to be sent at a desired frequency to specific recipients. 
 
Creating an Alert 
 
Your dashboard must be out of edit mode to create alerts. Alerts can only be set on tiles that 
have at least one numeric measure or table calculation in the tile’s visualization. 
Steps: 

1. Click the bell icon and then click the New button at the bottom of the list of existing 
alerts. If no alerts currently exist for that tile, clicking the bell icon will open the alert 
creation pop-up. 
 

 
 

 
 

 
 

2. In the alert creation pop-up, you can specify several components of your alert: 
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Custom Title: The default alert title indicates which conditions need to be true for the 
alert to be triggered. If you would like to rename your alert, click the three-dot menu, 
and then click Edit Alert. Click once on the alert title, enter a custom title, and then click 
away from the field or hit the Enter key to see your update. Click Save Alert to save your 
new title. Your custom alert title will appear in any publicly visible alerts listed in the 
alert view pop-up on that tile. The custom title will also appear in the alert notifications. 
 
Alert Condition: In the Condition drop-down in the alert creation pop-up, you can set 
alert conditions for numeric measures or table calculations in the tile’s query 
visualization. 
 
Recipients: Each recipient will receive an email with information about the alert and an 
option to unfollow the alert. If they choose to unfollow the alert, their email address will 
be removed from the recipient list. 
 
Frequency: You can set the frequency at which system will check your data for changes 
and to send an alert notification if the alert conditions are met. The default frequency 
is Daily at 05:00. For Hourly and Minutes frequency, Start and End times are inclusive. 
For example, if you set Check every to 12 hours with a Start time of 05:00 and 
an End time of 17:00, Looker will check the data at 05:00 and 17:00. 
 

3. Click on Save Alert. Alert created will now appear in Alerts pop-up. 
 
Dashboard filters in Alerts 
 
Alerts will take into account the standard dashboard filters that exist when the alert is created. 
If any dashboard filters are added or modified, the existing alerts will not incorporate those 
additions or changes, and you must create a new alert to capture those filter updates. 
You can see which dashboard filters apply to the alert in two places: 
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• In the list of alerts in the alert view pop-up 
• In the alert creation pop-up 

In the alert view pop-up, click the filter link under the alert: 
 

 
 
This opens a pop-up with additional details about the dashboard filters that are applied to that 
alert. 
 

 
Click Done to close the filter detail pop-up. 
 
You can also see which dashboard filters would apply to an alert as you create it. In the alert 
creation pop-up, click the filter icon in the upper right corner. 
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This opens a pop-up with additional details about the dashboard filters that would be applied to 
your alert once you create it. 

 

 
Click Done to close the filter detail pop-up. 
 
Modifying an Alert 
 
Click the three-dot menu to the right of the alerts listed in the alert view pop-up to edit, 
duplicate, or delete alerts. 

 
 



 24 

• To edit an alert, click Edit Alert to open a pop-up to edit the existing alert settings; when 
you’re finished editing, click Save Alert.  

• To duplicate an alert, click Duplicate to open a pop-up pre-populated with the existing 
alert settings, and then click Create Alert. Duplicating an alert creates a new alert with 
identical tile settings to the original alert. The duplicated alert query will check if 
conditions are triggered based on the dashboard and tile settings at the time 
the original alert was created. If any user has made changes to the dashboard or tile 
since the creation of the original alert, the duplicated alert will not pick up those 
changes. 

• To delete an alert, click Delete, and then confirm in the resulting pop-up. Click Done to 
close the alert view pop-up.  

 
Receiving an alert notification 

Once the alert is triggered, any specified recipients will receive an email notification at the 
specified frequency that includes: 

• A link to the dashboard for the tile on which the alert is based (Note: Please do no click 
on the link. It does not work as of now) 

• The value that triggered the alert 

• Options to unfollow or, depending on your permissions and who owns the alert, to edit 
the alert 

If you choose to unfollow the alert, you will be removed from the alert’s recipient list and will 
no longer receive notifications when the alert is triggered. If you unfollow on behalf of a group 
email address, group members will no longer receive notifications when that alert is triggered. 
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Section 7: Editor and Viewer user access details 

The below list shows what actions a user with Editor or Viewer permissions can perform in the 
new Safety Intelligence module.  

 Actions Allowed Editor Access Viewer Access 

Edit Dashboard Yes No 

Edit Dashboard on Home Page Yes No 

Add Filters Yes No 

Add Tile Yes No 

Edit Tile Yes No 

Save As (Dashboard) Yes No 

Download (Dashboard) Yes Yes 

Download Data (Look) Yes Yes 

Schedule delivery Yes Yes 

Set up Alerts Yes No 

Delete Dashboard Yes No 

Apply Site Filter Yes Yes 

View Popular dashboards Yes Yes 

Filter data Yes Yes 

Embed Link Yes Yes 

View embedded dashboards Yes Yes 
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Glossary 
 
Common Terms 
 
Dashboard 
A dashboard is essentially a collection of one or more saved queries, displayed as visualization or text 
tiles together on one page. 
 
Explore (n.) 
An Explore is the starting point for queries. An Explore shows a specified set of fields from its associated 
view file, and these fields can be selected from the field picker to construct a query, which can be saved 
as a Look or dashboard tile. Explore URLs can also be shared. 
Look (n.) 
A Look is a single table or visualization saved as its own individual report. Looks can be added to 
dashboards, scheduled and shared. Any changes made to a Look will be reflected in any dashboards that 
contain it. 
 
Tile 
Tiles are visualizations added to a dashboard from an Explore or a Look. Tiles can be query-based or 
Look-linked. Query tiles differ from Look-linked tiles because they are stored only on dashboards. 
 
Understanding Date Filters 
 

Today 31-Mar-21  
Timeframe   
(both days inclusive) From To 
Last 7 days 25-Mar-21 31-Mar-21 
Last 14 days 18-Mar-21 31-Mar-21 
Last 28 days 4-Mar-21 31-Mar-21 
Last 30 days 2-Mar-21 31-Mar-21 
Last 90 days 1-Jan-21 31-Mar-21 
Last 180 days 3-Oct-20 31-Mar-21 
Last 365 days 1-Apr-20 31-Mar-21 

   
Week is from Monday to Sunday   

   
This week 29-Mar-21 4-Apr-21 
This Month 1-Mar-21 31-Mar-21 
This Quarter Jan March 
This Year 2021 2021 

 01-Jan 31-Dec 
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Previous Week Last Monday Last Sunday 
Previous Month 1st of previous month last date of previous month 

Previous Quarter 
1st of previous 

quarter 
last date of previous 

quarter 
Previous Year 2020 2020 

 01-Jan 31-Dec 

   
Advanced   
 From To 
is in the last complete 1 week Last Monday Last Sunday 
Is in the last 1 week (is current 
week) 29-Mar-21 4-Apr-21 

 
 
 
 


